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Medical Center &
Chaplaincy

Department
Overview University Hospital ® University Hospital East

System Comprised of 7 Hospitals

_ Ross Heart Hospital * Harding Hospital
Key Facts and Figures

James Cancer Hospital * Dodd Rehab Hospital

Brain and Spine Hospital

w

THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

The Ohio State University Wexner
Medical Center is a Level 1 Trauma
academic medical center located
on the campus of The Ohio State
University in Columbus, Ohio
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Medical Center
& Departmental
Overview

Key Facts and Figures

1,321 Beds

59,358 Inpatient Admissions Annually

1.72 Million Outpatient Visits Annually

130,680 Emergency Department

Visits Annually

THE OHIO STATE UNIVERSITY
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Medical Center
& Departmental
Overview

Key Facts and Figures

4,999 Births Annually

41,852 Surgeries Annually

22,110 Employees




Medical Center &
Departmental
Overview

Key Facts and
Figures
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Medical Center &
Departmental
Overview

Key Facts and
Figures

Chaplaincy Department Staffing in
2014
= 1 FTE Director
= 1 FTE CPE Program Manager
= 1 FTE Administrative Assistant
= 6 FTE Staff Chaplains, 1 PT (.75)
1 Vacant FT position

= 2 IRP (as needed) Positions

6 “Work Study” student chaplains
= 2 Contract Catholic Priests

= 5 Year-long Residents

6 CPE Summer Interns

3/28/2017

] THE OHIO STATE UNIVERSITY
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Strategic planning process
implemented in recognition of the
following challenges:

= Inadequate staffing
= Inadequate afterhours coverage

= Limited CPE programming due to
staffing

= Poor connection to community clergy

= Lacking in research and metrics

Limited visibility and engagement of
chaplains beyond bedside

. ] THE OHIO STATE UNIVERSITY

'WEXNER MEDICAL CENTER
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Strategy Formation

M e d ICaI Ce nte r & Identify mission, vision and values
External competition and market analysis
D e p artm e ntal Internal analysis of resources and capabilities

Overview Strategy Translation

Identify goals and objectives
|dentify priorities based on goals

Strategic Planning
Process

Strategy Execution

Action plans and resource requirements

Monitor and Review

Strategic indicators and performance tracking
Annual review of assumptions, trends and goals

] THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

i Planning: January 2014 — May 2015
Medical Center g y y

& Departmental Implementation: May 2015 — June 2019
Overview
Strategic
Planning
Process
Timeline

@
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Work ge

Laying the
Ground
Work

Consulted with medical center’s
strategic planning department

Provided vital information about
chaplaincy, our staff and our
goals

Received feedback on how to
proceed

/W THE OHIO STATE UNIVERSITY
W WEXNER MEDICAL CENTER
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= Project Charter
Laying the
Ground = Project Scope
Work = Professional Experts and
Champions
= Literature Review
= Strategic Team Formation
= Vision, Mission and Values
= Key Consumers of Services
0 o
Project Charter included:
Laymg the = Problem Statement
Ground

Work = Project Scope

) = Deliverables
Project
Charter = Expectations
= Key Customers
= Milestones

= Estimated Completion Dates

@ THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER




Laying the
Ground The scope of the project was aimed at:
Work = Addressing more fully the spiritual needs of
patients, families and staff
Project » Nurturing connections with local faith
Scope communities to enhance spiritual support to
our patients
= Developing and expanding our CPE
programming
@ THE OHIO STATE UNIVERSITY
Laying the
Ground
Work
ldentifying
Professional
Experts and
Champions
THE OHIO STATE UNIVERSITY
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Laying the
Ground
Work

|dentifying
Professional
Experts and

Champions healthcare and chaplaincy (George
Handzo, George Fitchett)
= Commitment to the time demands
of serving on strategic planning
committee
\@ THE OHIO STATE UNIVERSITY
Extensive literature search and review
Laying the of scholarly articles focused on:
Ground = Best practice in pastoral care
Work . .
= Emerging trends in health care
) ] chaplaincy
Engaging In
LItFeQrea:;[iuerv?l = Evidence-based outcomes

T

Consulted individuals within and
outside medical center who have:

Positions of power and influence
(key stakeholders)

» Key medical center stakeholders in
positions of power and influence

= Expertise in areas relevant to

3/28/2017

= Research in chaplaincy

» Link between medical outcomes
and provision of spiritual care

. ] THE OHIO STATE UNIVERSITY

'WEXNER MEDICAL CENTER
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Strategic Planning Committee
Team Members by Discipline

Laying the = Administrative Director of Patient
Ground Work Experience

= Service Line Administrative of Stephanie

] Spielman Comprehensive Breast Center
Formulation of

Interd|SC|pI|nary = Chaplaincy Department CPE Program
Strateglc Manager

Plannmg Team = Chaplaincy Department Staff Chaplain

= Medial Center Researcher and Muslim
Faith Partner/Physician/Researcher

= Chaplaincy Department Director

= Nurse Manager and Pastoral Care
Advisory Committee Member

] THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

i Department of Chaplaincy and
Layl n g th e Clinical Pastoral Education
Ground

Work

Patient Care
Spiritual,
Pastoral and
Emotional
Care

Review and
Update of
. . Research
Improving .
. M 1SSI0N : Chaplaincy through Clirllzig;juc—;lz::)ra|
Participating in C
Visionidie oyt | S,
Val ues Practice Initiatives, Raten=landliaiics

and Promoting
Research Literacy

. ] THE OHIO STATE UNIVERSITY

WEXNER MEDICAL CENTER
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Laying the

Ground =  Patients and Families
Work
= Faculty and Clinical Staff
Identification
of Key = CPE Students
Consumers
of Services = External Partners
= |nternal Partners

THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

Department of Chaplaincy and CPE Consumers

ICUs (MICU, SICU, 8ICU)

ED/Trauma 1 & 2

Labor and Delivery, High Risk, NICU, Fetal Demise
The James (Oncology)

Burn Unit

Ross Heart Hospital

Ambulatory Clinics (James, Stephanie

Spielman CBC, Stoneridge, Martha Morehouse

« Dodd Hall (Physical Rehab)

OSU East & Talbot Hall (Addiction Services)

Patients &
Families
(request, don’t
request, unaware,
decline)

- Residents F_a(_:u“y (3 +  Physicians
+  Summer Interns CPE Clinical Staff + Nurses
«  Extended Interns Students DEPARTMENT (personal use of « PCAs
p u OF pastoral . i
. (Scommqmty/p;mgrs)t (current and CHAPLAINCY care/emotional X gnf'”.a A y
upervisory Students potential) AND CPE T eligious service

CONSUMERS services) worship attendees
« STAR Program

« Local religious leaders
(Pastors, Priests,

Imams, Rabbis, etc.) « Physicians

+ Seminaries (CPE) Fagjlt%/ & . mgrsses hggz)rse Managers,
. Een;mln;xggr;lllFalth Group External (profesasional . Mental Health
eacers Partners i

. o ’ use of pastoral *  Social Work

éiso?lgtlon:;grofessmnal (Non-OSU) care/ emotional « Palliative Care

aplains ( )A ) support services « Ethics

+ Association of Clinical Pastoral for patients) @ THE OHIO STATE UNIVERSITY

Education (ACPE) WEXNER MEDICAL CENTER
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Part Il:
Collection of
Data

THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

Part Il:
Collection of
Data

5 Sources of Data

Faculty and Clinical Staff Survey

CPE Program Survey

Clergy Faith Partners Survey

Peer Benchmarking Survey

Chaplain Internal Staff Survey

12
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Collection
of Data

Faculty and
Clinical Staff
Survey

Collection
of Data

Faculty and
Clinical Staff
Survey

Created online survey through

3/28/2017

Survey Monkey to seek feedback

from:
= Nursing

Social Work

Palliative Care

= Physicians

Survey administered via email and
comprised of 10 questions regarding
initiation, delivery and effectiveness of
chaplaincy services to identify:

= Areas that are working well

= Areas that are broken

= Elements that are missing

= Current effectiveness

= Chaplaincy services in ideal future

= Additional comments/suggestion@

THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER
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Respondents

Total of 235 respondents

Heavily based in inpatient, but spread across clinical
areas

= Cancer

Critical Care

Med Surg

Cardiac

Other Specialty Care

] THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

Nurses
n=105
Primary Work Setting

Outpatient,
5.7%

Inpatient,
94.3%

@ THE OHIO STATE UNIVERSITY
WEXNI

ER MEDICAL CENTER
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Nursing Clinical Areas

Critical Care,
18.3% Med Surg,
49.0%

Cancer, 30.8%

Specialty , Cardiac,
20.2% 15.4%

Palliative Care
n=11

Primary Work Setting

Outpatient,
36.4%

Inpatient,

63.6%

3/28/2017

] THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

/W THE OHIO STATE UNIVERSITY
W WEXNER MEDICAL CENTER
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Palliative Clinical Areas
Specialty ,
100.0% 100.0%

90.0%
80.0%
70.0%
60.0%
50.0%
40.0% Mezi :Sg(lf/gg Cardiac,
30.0% : 27.3%
20.0%
10.0%

0.0% ‘ ‘

Med Surg Cardiac Specialty Cancer Critical Care
0 o

Social Workers
n=32

Primary Work Setting
21.9%
Outpatient

Inpatient,

78.1%

. ] THE OHIO STATE UNIVERSITY

WEXNER MEDICAL CENTER

16



3/28/2017

Effectiveness Meeting Pt and Staff Needs in Your
Department? (Palliative)

Not at all Somewhat
Effective, ive, _Very Effective,
0.0% 32.7%
Ave = 3.82

] THE OHIO STATE UNIVERSITY
_ 'WEXNER MEDICAL CENTER

Effectiveness Meeting Pt and Staff Needs in Your
Department? (Social Work)

Somewhat Very Effective, Not at all
Ineffective, 9.4% Effective,
6.3% 0.0%
Ave = 3.75

. W THE OHIO STATE UNIVERSITY
-

'WEXNER MEDICAL CENTER
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Collection Survey results helped us to identify
of Data
» Strengths to retain/leverage
F_a(_:ulty and = \Weaknesses/opportunities
Clinical Staff
Survey = Gaps
= Possibilities
= Priorities per respondents
\@ THE OHIO STATE UNIVERSITY
Collection = Current Students
of Data
» Former students
CPE » Staff Chaplains
Program
Survey » Local Seminary Liaisons
;\q\ou \'.\\f'\l ‘:‘\\/ <K o )
o 30 ‘ese:\s‘\
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103dV df X u
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WEXNER MEDICAL CENTER
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Collection Series of 10 questions,
f Dat administered via phone by outside
0 ata volunteer to identify:
=  Strengths
CRE
Program = Weaknesses
Survey
L aH T goste® = Opportunities for growth
;\q\ou \'-\\"\NA\\[ 5O it . .
g 9 % ewese“*k = Current effectiveness
\e of R :
owd _am - » Comments/suggestions
200 3¢ ‘cx‘ep‘zfj X\
PR ou \evel i a2 \@ THE OHIO STATE UNIVERSITY
Collection Series of 10 questions,
f Dat administered via phone by staff
0 ata chaplain to identify:
. = Strengths
Clergy Faith
Partners = Weaknesses
Survey
e g = Opportunities for growth
:\qoun\\"‘ A“/ 50 ' .
o \‘jfl“’“ = Current effectiveness
\e of w\e “w®
LR - Tl e ts/ t
- ‘ev@‘e{f‘\w omments/suggestions
O T B oY \eue OJ o
e - oot
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Collection of
Data 2 -
INDIGATOR & T
EvmuanunMETRlCS & CUST ETHODOLOGY =X
Peer TECHNICAL b = rncrons BEST PRACTICESES TARGET
Benchmarkin FIVARGI B
| nterviewg manasevent Survey T0OLS BEN CH MAR KI NG
PROCESS &3 PERFORMANGE st
e = INDUSTRY =™ 2 &
=
0 s oo Stare Dnnvimormy
Collection of Interviewed chaplaincy department
directors of 7 “like” medical centers:
Data _
» Baystate Medical Center
Peer . Barmes-Jewish Hospital
Benchmarking
Interviews = Brigham and Women’s

Indiana University Health
University of California Los Angeles

University of Virginia Health System

Wake Forest Baptist Hospitals THE ORIO STATE UNIVERSITY

WEXNER MEDICAL CENTER
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Collection of Series of 8 questions, administered
D via phone by Chaplaincy
ata Department director to identify:

Staffing structure
Peel Manager/Director roles
Benchmarking Certification requirements
Interviews CPE programing

Clinical coverage

Prioritized use of staff and students
Afterhours/on-call coverage

Staff support

Volunteer programming

Data collection and metrics
Engagement in research

] THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

Collection Series of 10 questions via phone
fD by outside volunteer to identify the
0 ata effectiveness of the chaplaincy
department in meeting patient and
Chaplain staff needs:
Staff Internal = Strengths

Surve
y = \Weaknesses

= Opportunities for growth
= Current effectiveness

= Comments/suggestions

. ] THE OHIO STATE UNIVERSITY

WEXNER MEDICAL CENTER
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Effectiveness Meeting Pt and Staff Needs in Your
Department? (Chaplain List)

Somewhat Not at all

Neutral,

Very Effective,
46.4%

Ave = 4.36

] THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

Formation of Data Review Teams

Part Il

Data Mining and  Creation of Data Summaries
Synthesizing

Development of Strategic Plan SWOT Analysis

=
i

22
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Formulation of Data Review Teams

= 4 data review teams formed

Data Mining

_ Qnd » Teams of two with buddy system
Synthesizing

= Extensive data review process

@ THE OHIO STATE UNIVERSITY
_ 'WEXNER MEDICAL CENTER

Creation of Data Summaries

= All raw data reviewed and synthesized

Data Mining into one page summaries
and
Synthesizing * Buddy to review written summary for

accuracy

= Presentation of summaries to larger
group

= Feedback given and revisions made

@ THE OHIO STATE UNIVERSITY
46 &9 WEXNER MEDICALCENTER
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Data Mining \WeaknesseS
and stren%‘\"s
Synthesizing SNOT
P\“a\\'é\s
Ww\es
crunt
opPr°
™ THE OHIO STATE UNIVERSITY
47 'WEXNER MEDICAL CENTER
SWOT Analysis
Data Mining Summaries us_ed to create
and SWOT analysis
Synthesizing

SWOT reviewed and revised by
strategic planning team

/W THE OHIO STATE UNIVERSITY
W WEXNER MEDICAL CENTER
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Overview of SWOT Analysis
Strengths Weaknesses

* Chaplain presence & accessibility * Chaplains spread thin
Level of expertise * Some inconsistency in service and
Quality, caliber and reputation of EVETEo]1113Y
i department & CPE program Inadequate afterhours coverage
Data Mlnlng Diversity in experience and faith No participation in QI processes
and traditions Only 2 CPE supervisors
.- Initial presence in ambulatory Extended CPE discontinued
SyntheS|Z|ng ahead of industry Limited bereavement services
Integration with clinical teams Lack of clarity of who to contact &
when
Opportunltles Threats
Further collaboration & integration « Budget and financial pressures
with medical team » Changes in WMC leadership
» Form connective relationships w/area  + Lifestyle/workload considerations
churches & University Hospital East related to on-call duties

» More proactive support for staff

» Focus toward evidence based
practice

» Senior level support & endorsement

] THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

Development of Goals, Strategies, Tactics and

Part |\: sk

F|nal|2|ng of Feedback and Revisions
Strategic Plan

Prioritization of Tasks

Assigning and Execution of Tasks

Presentation of Final Plan to Key Stakeholders

25



Finalizing of
Strategic Plan

Finalizing of
Strategic Plan

3/28/2017

Based on SWOT Analysis 3 goals
were developed to focus on:

Offering world class spiritual care to
patients, families and staff

Strengthening relationships with
local clergy/faith leaders

Advancing the CPE Program

] THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

Clear strategies, tactics and tasks were
created for each goal

Goals, tactics and tasks underwent
battery of revisions

Tasks prioritized based on urgency and
review of resources

Realistic timelines for each task set
Assignments given to chaplaincy staff

based on current involvement, interest,
and skill level

. ] THE OHIO STATE UNIVERSITY

WEXNER MEDICAL CENTER
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» Final report prepared and presented to
i = key stakeholders (CEO/COO of each
Flnall_zmg of business unit/hospital) for feedback
Strategic Plan

» Made additional revisions to incorporate
feedback

» Strategic plan presented to Pastoral
Care Advisory Committee at quarterly
PCAC meeting

» Strategic plan presented to Chaplaincy
Department staff at %2 day retreat

] THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

Part V.

Strategic Plan
Implementation:
Phase 1

(We have a lot to smile about!)

27
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e —
New Strategic Plan-Optimal Pastoral Care

THE OHIO STATE UNIVERSITY James Cancer Hospital

WEXNER MEDICAL CENTER

Part V Revamped Department Administrative Structure

Strateg | C PI an Staffing Expansion
Im p lementation: CcPE Program Changes and Expansion
Ph ase 1 Provision of Pastoral Care

Spiritual Care Education for Staff

Development of Staff Support Services

Increase in Chaplain Visibility and Influence

Technological Advances

Metrics/Measurement Develogment

= Quarterly meetings between Chaplaincy

Strategic Plan Director and James Chief Nursing Executive

Implementation:

Phase 1 .« Executive was aware of strategic planning

_ process and goals
Optimal Pastoral Care for

James Cancer Hospital = In August 2015, Executive invited Chaplaincy

Director to develop “optimal pastoral care plan
for James patients, families and staff for all
shifts and all patients, both inpatient and
ambulatory”

. ] THE OHIO STATE UNIVERSITY

'WEXNER MEDICAL CENTER
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Strategic Plan
Implementation:
Phase 1

Optimal Pastoral Care for
James Cancer Hospital

Strategic Plan
Implementation:
Phase 1

3/28/2017

If plan was accepted, a Service Line
Agreement (SLA) would be developed to
specify services/staff Chaplaincy would provide
in exchange for funding

Director presented this invitation to staff

New strategic planning process developed
within weeks for chaplains to work on

Chaplain Imani Jones put in charge of
oversight of strategic plan

Subcommittees formed and
assignments/timelines made

] THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

Elements of Strategic Plan

Analyzed trend in volume/frequency of pastoral
services from July 2014 — October 2015
(oncall logbook review)

Used GRASP Pastoral Care Staffing Model to
determine minimum day shift inpatient
chaplains needed

Conducted online survey (Qualtrics) of Clinical
staff (200 respondents)

Held face to face feedback meetings with ICU
nurse managers regarding optimal pastoral

services
THE OHIO STATE UNIVERSITY

'WEXNER MEDICAL CENTER
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-]
Elements of Strategic Plan

= Conducted benchmarking conversations with
“like” cancer centers nationally

Strategic Plan
9 Conducted phone meetings with pastoral care

Implemepnl,fatlon]i thought leaders (George Handzo, George
ase Fitchett)

» Conducted literature review related to:
spiritual care

oncology

spiritual needs

spiritual distress

quality of life

patient satisfaction

YVVVVYY

'WEXNER MEDICAL CENTER

] THE OHIO STATE UNIVERSITY

Elements of Strategic Plan

Compared Wexner Medical Center/James
pastoral services to APC Standards of Practice

Strategic Plan
Implementation:
Phase 1

Optimal Pastoral Care for
James Cancer Hospital

. ] THE OHIO STATE UNIVERSITY

WEXNER MEDICAL CENTER

30



3/28/2017

Proposal Development

] » Subcommittee work/findings reviewed and
Strategic Plan discussed by all staff
Implementation:
Phase 1 = Draft proposal of optimal staffing/services
developed, discussed and finalized by all staff
Optimal Pastoral Care for
James Cancer Hospital = Director wrote proposal document with
input/feedback from Manager and Service Line
Administrator

'WEXNER MEDICAL CENTER

] THE OHIO STATE UNIVERSITY

Proposal Development

= Process, from initial conversation with

Strategic P|an Executive to delivery of proposal, took 5
Implementation: months
Phase 1

= Additional 90 days (mid-March 2016) until

Optimal Pastoral Care for meeting occurred to discuss details
James Cancer Hospital

= Proposal accepted!

. ] THE OHIO STATE UNIVERSITY

WEXNER MEDICAL CENTER
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Strategic Plan
Implementation:
Phase 1

Optimal Pastoral Care for
James Cancer Hospital

Strategic Plan
Implementation:
Phase 1

Revamped Department
Administrative Structure

3/28/2017

Proposal Outcome
Inpatient Units: 4 FT Chaplains
ICU Unit: 1 FT Chaplain
Breast Center/Mill Run Ambulatory Clinic: | FT Chaplain
Martha Morehouse Ambulatory Clinics: 1 FT Chaplain
Night Chaplain (10pm — 8am): 1 FT Chaplain

Swing Shift Ambulatory Clinic/Evening (12p-10p) 1 FT
Chaplain

Weekend Day (Fri-Sun 8am — 8pm): 0.9 FT Chaplain (36/wk)
Weekend Night (Fri-Sun 8pm — 8am):0.9 FT Chaplain (36/wk)
Total chaplains dedicated to James Cancer Hospital: 10.8
Total new hires: 8.8

THE OHIO STATE UNIVERSITY

Additional Office Associate approved 12/16 WEXNER MEDICAL CENTER

Realignment of Department Leadership Roles

» Developed Manager role:
* Operational oversight
« Scheduling
* Onboarding
« Orientation

« Supervision of afterhours staff

@ THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER
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Strategic Plan
Implementation:
Phase 1

Revamped
Department
Administrative
Structure

Chaplaincy Department Staffing in
2014

1 FTE Director

1 FTE CPE Program Manager

1 FTE Administrative Assistant

6 FTE Staff Chaplains, 1 PT (.75)
1 Vacant FT position

2 IRP (as needed) Chaplains

6 “Work Study” student chaplains
2 Contract Catholic Priests

5 Year-long Residents

6 CPE Summer Interns

3/28/2017

Realignment of Department Leadership Roles

> Director role

Capacity to focus on strategic vision

Involvement in new medical center
committees and initiatives
o James Patient Experience Council
o James Bereavement Plan Steering
Committee
o Hospice Development Committee

Increase CPE supervisory capacity

] THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

Staffing Expansion
Chaplaincy Department Staffing in

2017

1 FTE Director
1 FTE Department Manager
1 FTE Administrative Associate
1 FTE CPE Program Manager
1 FTE Office Manager
1 FTE Office Associate (vacant)
15 FTE Staff Chaplains
o 2 FT (0.9)
o 1 Vacant
1 PT (.75)
2 IRP (as needed) Chaplains
2 Contract Catholic Priests
5 Contract (as needed) Chaplains
8 Year-long CPE Residents

THE OHIO STATE UNIVERSITY

6 CPE Summer Interns 'WEXNER MEDICAL CENTER
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CPE Program Changes and Expansion

= 3 Additional resident positions in 2015
(James funded)

Im?)ﬁrearaeegr:gaﬁﬁp = Hiring of new CPE Program Manager
1 o Job description updated
Phase 1 o Contracted with Thorne Consulting
o Advocated for increased salary range,
which was approved

= Addition of Supervisory Education
Accreditation in May 2016

] THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

CPE Program Changes and Expansion

= Addition of CPE Resident rotation at

. University Hospital East
Strategic Plan Y HosP

Implementation: Considering offering CPE Extended Unit,
Phase 1 Fall 2017

» Submitted Transforming Chaplaincy CPE
Resident Grant

@ THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER
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1
Provision of Pastoral Care Services

» Routine application of GRASP
Staffing Model for staff chaplain and
chaplain resident unit assignments

Strategic Plan

Implementatlon: » Chaplain unit assignments

Phase 1 increasingly based on service lines
rather than geographic location

= Development of contract chaplain
role utilizing Pastoral Care
Endowment Fund

'WEXNER MEDICAL CENTER

] THE OHIO STATE UNIVERSITY

Provision of Pastoral Care Services

= Development and implementation of
new flow sheet in Epic EMR by our
Strategic Plan chaplaincy staff
Implementatlon. = Enhanced pastoral care services
Phase 1 and staffing with CPE residents at
University Hospital East

=  Administrative assistant reclassified
to Office Manager

= Additional Office Associate
approved

@ THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER
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Strategic Plan
Implementation:
Phase 1

Spiritual Care Education for Staff

Spiritual Care Wellness Module for OSU College of
Nursing Students and OSU Your Plan for Health

= Presentations/modules/didactics done by staff
chaplains on clinical units

= Spiritual Assessment of Oncology Patients, Nursing
Grand Rounds and Psychosocial Grand Rounds

= Spirituality Module for James Cancer Hospital Nurse
Residency Program

= Hospice and Palliative Medicine Fellowship Spirituality
Curriculum

] THE OHIO STATE UNIVERSITY
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Strategic Plan
Implementation:
Phase 1

Development of Staff Support Services

= Bereavement Support for James Nurses
through Remembrance and Renewal Program

Staff chaplain attendance and involvement in
Schwartz Center Rounds

Staff chaplains trained in Peer Support Staff
(BEST) Program

= Invited to partner with Mental Health Clinical
Nurse Specialists at The James

= Offer annual employee remembrance service
(planning phase)

= Invite employees to attend quarterly patient

@ THE OHIO STATE UNIVERSITY

memorial services
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Strategic Plan
Implementation:
Phase 1

Increase in Chaplain Staff Visibility
and Influence

Attending more meetings,
interdisciplinary rounds, QI, Patient
Experience, Ethics, etc.

= Serving on various Medical Center

committees

= Director and manager attending

hospital leadership meetings

= Director invited to sit on key

committees

] THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER

Strategic Plan
Implementation:
Phase 1

Technological Advancement

Spiritual Care App development
through OSU Capstone Program

Internal chaplaincy website
enhancements

Increasing use of technology in
provision of pastoral care

Implementation of App-based
scheduling software for on-call and
departmental tasks

. ] THE OHIO STATE UNIVERSITY
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Strategic Plan
Implementation:
Phase 1

Metrics/Measurement Development

= Expected by James Service Line
Agreement (SLA)

= Becoming general expectation of all
departments within medical center

= Committee formed to explore
current best practices and develop
dashboard to measure chaplaincy
effectiveness

= Partnering with James Data
Analytics Department to assist with
metrics from E-Chart and patient

satisfaction data \@ THE OHIO STATE UNIVERSITY
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Strategic Plan
Implementation:
Phase 1

Strategic Plan Ongoing Monitoring
and Reviewing:

Chaplain manager tracks progress,
maintains timelines for task
completion

= Annual department retreat to set

department goals related to
strategic plan for next fiscal year

= Consistently keep champions and

key stakeholders informed of
progress and new developments

. ] THE OHIO STATE UNIVERSITY
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Strategic Planning Advice

= Engage in ongoing assessment of:
o spiritual services provided
o gaps in coverage
o needs you have (staffing,
- . administrative, financial, etc.
Conclusion: )

Lessons Learned = Partner with individuals/departments in
your organization with specific
backgrounds, skill sets and areas of
expertise:

o MBAs

o Researchers

o Strategic Planning Department
o Data/Analytics Department

© Development Department THE OHIO STATE UNIVERSITY

Strategic Planning Advice

= Do your homework and provide evidence-
based data to hospital administrators to
support your case for requesting additional

Conclusion: funding and resources

Lessons Learned = Create opportunities for chaplain staff to
partner in strategic initiatives. Directors
and managers can’t do this alone!

= Justdo it — even if you feel inadequate,
you can figure it out as you go!

@ THE OHIO STATE UNIVERSITY
'WEXNER MEDICAL CENTER
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Questions?

] THE OHIO STATE UNIVERSITY
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